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Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the
operation of semiconductor products and application examples. You are fully responsible for the incorporation of these
circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for
any losses incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas
Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever
for any damages incurred by you resulting from errors in or omissions from the information included herein.

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property
rights of third parties by or arising from the use of Renesas Electronics products or technical information described in
this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other
intellectual property rights of Renesas Electronics or others.

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or
in part. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such
alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High
Quality”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade,
as indicated below.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio
and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial
robots etc.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster
systems; anticrime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a
direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may
cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality
grade of each Renesas Electronics product before using it in a particular application. You may not use any Renesas
Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable
for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for
which the product is not intended by Renesas Electronics.

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas
Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage
range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no
liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified
ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products
have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use
conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to
implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by fire
in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including
but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or
any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult, please
evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all
applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation,
the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your
noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You should not
use Renesas Electronics products or technology described in this document for any purpose relating to military
applications or use by the military, including but not limited to the development of weapons of mass destruction. When
exporting the Renesas Electronics products or technology described in this document, you should comply with the
applicable export control laws and regulations and follow the procedures required by such laws and regulations.

10. Itis the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or
otherwise places the product with a third party, to notify such third party in advance of the contents and conditions set
forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as
a result of unauthorized use of Renesas Electronics products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of
Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its
majority owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(2012.4)




Disclaimer

By using this Renesas Starter Kit (RSK), the user accepts the following terms:

The RSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK is
assumed by the User. The RSK is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK, even
if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK product:

This Renesas Starter Kit is only intended for use in a laboratory environment under ambient temperature and humidity
conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the
laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the
Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 20m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Application Leading Tool
(Code Generator) for RX together with the CS+ IDE to create a working project for the RSK platform. It is
intended for users designing sample code on the RSK platform, using the many different incorporated
peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into CS+, but does not
intend to be a complete guide to software development on the RSK platform. Further details regarding
operating the RX23T microcontroller may be found in the Hardware Manual and within the provided sample
code.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX23T Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Description Document Title Document No.
Type

User’s Manual Describes the technical details of the RSKRX23T User’s Manual R20UT3318EG
RSK hardware.

Tutorial Manual Provides a guide to setting up RSK RSKRX23T Tutorial Manual R20UT3319EG
environment, running sample code and
debugging programs.

Quick Start Provides simple instructions to setup the RSKRX23T Quick Start Guide R20UT3320EG

Guide RSK and run the first sample.

Code Generator Provides a guide to code generation RSKRX23T Code Generator | R20UT3321EG

Tutorial Manual and importing into the CS+ IDE. Tutorial Manual

Schematics Full detail circuit schematics of the RSK. RSKRX23T Schematics R20UT3317EG

Hardware Provides technical details of the RX23T RX23T Group Hardware | RO1UHO0520EJ

Manual microcontroller. Manual




2. List of Abbreviations and Acronyms

Abbreviation

Full Form

ADC Analog-to-Digital Converter

API Application Programming Interface

bps Bits per second

CMT Compare Match Timer

COM COMmunications port referring to PC serial port

CPU Central Processing Unit

DVD Digital Versatile Disc

El Renesas On-chip Debugging Emulator

GUI Graphical User Interface

IDE Integrated Development Environment

IRQ Interrupt Request

LCD Liquid Crystal Display

LED Light Emitting Diode

LSB Least Significant Bit

LVD Low Voltage Detect

MCU Micro-controller Unit

MSB Most Significant Bit

PC Personal Computer

Pmod™ This is a Digilent Pmod™ Compatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface_Specification

PLL Phase-locked Loop

RAM Random Access Memory

ROM Read Only Memory

RSK Renesas Starter Kit

RTC Realtime Clock

SAU Serial Array Unit

SCI Serial Communications Interface

SPI Serial Peripheral Interface

TAU Timer Array Unit

TFT Thin Film Transistor

TPU Timer Pulse Unit

UART Universal Asynchronous Receiver/Transmitter

UsSB Universal Serial Bus

WDT Watchdog timer

All trademarks and registered trademarks are the property of their respective owners.



http://www.digilentinc.com/index.cfm
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LENESANS

RSKRX23T
RENESAS STARTER KIT

R20UT3321EG0100
Rev. 1.00
Aug 24, 2015

1. Overview

1.1  Purpose

This RSK is an evaluation tool for Renesas microcontrollers. This manual describes how to use the CS+ IDE

code generator plug in to create a working project for the RSK platform.

1.2 Features

This RSK provides an evaluation of the following features:
« Project Creation with CS+

« Code Generation using the code generator plug in.
« User circuitry such as switches, LEDs and a potentiometer

The RSK board contains all the circuitry required for microcontroller operation.

R20UT3321EG0100 Rev. 1.00
Aug 24, 2015 RENESAS
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RSKRX23T 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, how to use the code generator plug in for the RX family
together with the CS+ IDE to create a working project for the RSK platform. The tutorials help explain the
following:

e Project generation using the CS+

e Detailed use of the code generator plug in for CS+
e Integration with custom code

e Building the project CS+

The project generator will create a tutorial project with three selectable build configurations:
o ‘DefaultBuild’ is a project with debug support and optimisation level set to two.
o ‘Debug’ is a project built with the debugger support included. Optimisation is set to zero.

o ‘Release’ is a project with optimised compile options (level two) and no outputs debugging information
options selected, producing code suitable for release in a product.

The tutorial examples in this manual assume that installation procedures described in the RSK Quick Start
Guide have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

These tutorials are designed to show you how to use the RSK and are not intended as a comprehensive introduction to
the CS+ debugger, compiler toolchains or the E1 emulator. Please refer to the relevant user manuals for more in-depth
information.

R20UT3321EG0100 Rev. 1.00 —————
Aug 24, 2015 RENESAS




RSKRX23T 3. Project Creation with CS+

3. Project Creation with CS+

3.1 Introduction
In this section the user will be guided through the steps required to create a new C project for the RX23T MCU,

ready to generate peripheral driver code using Code Generator. This project generation step is necessary to
create the MCU-specific project and debug files.

3.2 Creating the Project

To use the program, start CS+:
Windows™ 7 & Vista: Start Menu > All Programs > Renesas Electronics CS+ > CS+ for CC
(RL78,RX,RH850)

Windows™ 8.1 & 8: From Apps View @ click ‘CS+ for CC (RL78,RX,RH850)’ icon

e CS+ will show the Start Page. Use the Create New Project
‘GO’ button to Create a New Project. Anew project can be created

A new project can zlso be created by reusing the file configuration registered to an existing project.

Create New Multi-rnre Proient

e In the ‘Create Project’ dialog, select | | CreateProject ==
‘RX’ from the ‘Microcontroller’ pull- _
VIKCTOCON! L= -
down M troll RX (=]
e In the ‘Using Microcontroller’ list Using mécrocontraller
control, scroll down to ‘RX23T' and &) (Search microcontroller) Update.
expand the tree control by clicking ‘+'. % B0 <1 [Product Name: FEFS23 TS A

Select ‘R5F523T5AxFM(64pin)’. 5% RX23T Onrchip| DM size[KEnes]. 128
: _ . ¢4 R5FE23T2AFD(52pir) Onchip RAM size[Byles] | 2929
e Ensure that in the ‘Kind of project’ pull- RSF523T3AxFL(48pin) Aekdiiona krdammznon P ackago=RLOR D0GAE A
down, ‘Empty Application(CC-RX)" is RSF523T3AxF M(84pin)
lected -3 R5F523T5AF D(52pir)
se ' W REF523T54xF L (48pin)
e Choose an appropriate name and IR § SFO25TSAF ME4pin) o
location for the project, then click

|

‘Create’ Kind of project: Empty Application(CC-RX) [=]
Note: this tutorial assumes the project e nickne: CG_Tutoral
is named and located at the place Place: Cworkspace (=]

shown opposite.

e If the folder entered cannot be found a
‘Question’ dialogue will be displayed;

7] Make the project folder

Cworkspace\CG_Tutoria\CG_Tutorial mipj

CIiCk "Yes'. [T] Pass the file composition of an existing project to the new project
Project to be passed Browse.
position files ir ivert ject f r i W proj lder
Create ' Cancel Help

Aug 24, 2015




RSKRX23T 3. Board Layout

e CS+ will create the blank project with | [REEESLES 1 x Property
the standard project tree. A ‘Code A 3 @
Generator’ node may also be shown, if . “H Code Generator Property
previously enabled. EI-‘-EE CG Tutorial (Project 4 Generate File Mode
ﬁ R5F523T54xFM (Microcontroller) AP| output control
J Code Generator (Design Tool) Output folder
iy, CC-RX (Build Tool) File generation control
.t RX Simulater (Debug Tool) Register files
- File Reporttype
4 Product Information

R20UT3321EG0100 Rev. 1.00 RENESANAS Page 10 of 53
Aug 24, 2015



RSKRX23T 4.  Code Generation Using the CS+ plug in

4. Code Generation Using the CS+ plug in

4.1 Introduction

Code Generator is a Windows™ GUI tool for generating template ‘C’ source code and project settings for the
RX23T. When using Code Generator, the user is able to configure various MCU features and operating
parameters using intuitive GUI controls, thereby bypassing the need in most cases to refer to sections of the
Hardware Manual.

By following the steps detailed in this tutorial, the user will generate a CS+ project called CG_Tutorial. A fully
completed Tutorial project is contained on the DVD and may be imported into CS+ by following the steps in
the Quick Start Guide. This tutorial is intended as a learning exercise for users who wish to use the Code
Generator to generate their own custom projects for CS+.

Once the user has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are name ‘r_cg_xxx.h’, ‘r_cg_xxx.c’,
and ‘r_cg_xxx_user.c’, where ‘xxx’ is a three letter acronym for the relevant MCU feature, for example ‘adc’.
Within these code modules, the user is then free to add custom code to meet their specific requirement.
Custom code should be added, whenever possible, in between the following comment delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Code Generator will locate these comment delimiters, and preserve any custom code inside the delimiters on
subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-visit
Code Generator to change any MCU operating parameters.

The CG_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT),
the Serial Communications Interface (SCI) and uses these modules to perform A/D conversion and display the
results via the Virtual COM port to a terminal program and also on the LCD display on the RSK.

Following a tour of the key user interface features of Code Generator in 84.3, the reader is guided through
each of the peripheral function configuration dialogs in 84.4. In 85, the reader is familiarised with the structure
of the template code, as well as how to add their own code to the user code areas provided by the code
generator.

4.2 Enabling Code Generator

After installation of CS+, Code Generator must be enabled. This step is only required once, CS+ will
remember this setting on subsequent launches.

From the ‘Tool' pull-down menu select ‘Plug-in Setting...”. On the ‘Additional Function’ tab, click the box next to
the ‘Code Generator/Pin View Plug-in’ option and ensure it is ticked:

Basic Function

Description

[ .} Code Ganerator Plug-n Plug4n to generate the device driver automatically for VB50, 7BKD, TBKOR, RL78/G12, G13, G1
CodeGawﬁoran\ﬁav Plug-n Plug-in to generate the device driver automatically and to view the device corfiguration for RX,

Module Name

Click ‘OK’. CS+ needs to restart to enable this selection, select ‘Yes’ from the Question dialogue box.
After restarting, ‘Code Generator (Design Tool)' node will now be shown in the left-hand ‘Project Tree’ window

pane.
Project Tree 3 X
2 @ 3 & czl Code Generator Property
Eiv--,_% CG Tutorial (Project 4 Generate File Mode
% RSF523T5AxFM (Microcontroller) APl output control
R | Code Generator (Design Tool) | Output older
4\ CC-RX (Build Toel) File generation control
.55 RX Simulator (Debug Tool) Register files
@-[ File Report type _
4 Product Information
R20UT3321EG0100 Rev. 1.00 RENESAS Page 11 of 53
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RSKRX23T 4.  Code Generation Using the CS+ plug in

4.3 Code Generator Tour

This section presents a brief tour of Code Generator. For further details of the Code Generator paradigm and
reference, refer to the Application Leading Tool Common Operations manual.

You can download the latest document from: http://www.renesas.com/applilet

Application Leading Tool is the stand-alone version of Code Generator and this manual is applicable to the
Code Generator.

In the Project Tree pane, click on the icon next to ‘Code Generator’ node to expand the list.

Expand the ‘Peripheral Functions’ node by clicking on the next to it.

Open the ‘Peripheral Function’ tab by double clicking on the ‘Peripheral Functions’ name.

The CS+ main window will now contain a ‘Peripheral Functions’ tab with the Initial View as show in Figure 4-1.

@3 CG_Tutorial - C5+ for CC - [Peripheral Functions] = & =]
P CHlE-N P
File Edit View Project Build Debug Tool Window Help
@sat [EEH A X b @9 o508 & - @7 @R DefaultBuild A iy @O 5=
0P3RS
Project Tree B X | % broperty |5 Periphersl Functions =]
s @33

B] GenerateCode L 0 £ # BB A G DD D LTI T LS MR

=Lt CG Tutorial (Project) | =
188 RSF523T5AXFM (Microcontroller) | || C1°°K setting | Biock diagram

=" Code Generator (Design Tool) Main clock oscillator setting
-2 Pin View 7] Operation
" o .
= Ei Peripheral Functions Main dlock oscilation source Resonator =

& [Clock Generator, E

Voltage Detection Circuit o g (MHz)

Clock Frequency Accuracy N Oscillator watt time 8192 cycles - 2048 {us)
Interrupt Controller Unit

Low Power Consumption Cncllabion stop tetecon fundion Disabled v
bikes PLL circuit sefting

S VO Ports 7l o on

A Data Transfer Controller
Port Output Enable 3 = Input frequency division ratio x1 -

5% Multi-Function Timer Pulse iy AR P i =

Compare Match Timer Frequency 2 (MHz)
Independent Watchdog Tim
Serial Peripheral Interface Low speed clock oscillator (LOCO) setting

CRC Calculator ¥1 Operation =
Serial Communications Intey | |Outpul 7 X

12-Bit A/D Converter
D/A Converter
Comparator C
2C Bus Interface
&/ Data Operation Circuit
i-waf Code Preview
A, CC-RX (Build Tool) _ ||\ AllMessages / =
B : - 7 Output [l Error List

|FY Replace Next I F& Build & Downloa... 7 Build Project F8 Ignore Bresk an “H~+;| clete Break |18 Step Over FNStepIn 2 Jump to Function

.
n
-
-
-
=
-
=
-
« i 8-Bit Timer
-
n
"
=
S
(=
n
=
(s

< m

|F? Open Helpfor [ | F2 Repame

53 DISCONNECT

e — P | |

Figure 4-1 Initial View

Code Generator provides GUI features for configuration of MCU subsystems and peripherals. Once the user
has configured all required MCU subsystems and peripherals, the user can click the ‘Generate Code’ button,
resulting in a fully configured CS+ project.

Navigation to the MCU peripheral configuration screens may be performed by double-clicking the required
function in the Project Tree -> Project Name -> Peripheral Function on the left.

It is also possible to see a preview of the code that will be generated for the current peripheral function
settings by double-clicking the required function in the Project Tree -> Project Name -> Code Preview on the
left.

R20UT3321EG0100 Rev. 1.00 RENESAS Page 12 of 53
Aug 24, 2015
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RSKRX23T 4.  Code Generation Using the CS+ plug in

4.4 Code Generation

In the following sub-sections, the reader is guided through the steps to configure the MCU for a simple project
containing interrupts for switch inputs, timers, ADC and a UART.

44.1 Clock Generator

Figure 4-2 shows a screenshot of Code Generator with the Clock Generator function open. Click on the
‘Clock setting’ sub tab. Configure the system clocks as shown in the figure. In this tutorial we are using the
on board 20 MHz crystal resonator for our main clock oscillation source and the PLL circuit is in operation.
The PLL output is used as the main system clock and the divisors should be set as shown in Figure 4-2.

Peripheral Functions
5] GenerateCode | £ 1 & # WL B D DD BT IET O malES

Clock setting l Block diagram

Main clock oscillator setting -

[¥] Operation

Main clock oscillation source Resonator -
Frequency 20 (MHz)
QOscillator wait time 8192 cycles - 2048 [(T)]
Oscillation stop detection function Disabled -

PLL circuit setting

[¥] Operation

Input frequency division ratio x 172 -
Frequency multiplication factor x4 -
Frequency 40 (MHz)

Low speed clock oscillator (LOCO) setting
[ Operation

=

System clock setting

Clock source PLL circuit -

System clock {ICLK) x1 - 40 (MHz)
Peripheral module clock (PCLKA) x1 - 40 {MHz)
Peripheral module clock (PCLKE) % 1 - 40 {MHz)
Peripheral module clock for ADC (PCLKD) x1 - 40 (MHz)
Flash IF clock {FCLK) x 172 - 20 {MHz)

[WDT-dedicated low-speed clock oscillater (IWDTLOCO) setting
[] Operation

15

Figure 4-2 Clock setting tab

Proceed to the next section on Interrupt

R20UT3321EG0100 Rev. 1.00 RENESAS Page 13 of 53
Aug 24, 2015



RSKRX23T 4.  Code Generation Using the CS+ plug in

4.4.2 Interrupt Controller Unit

Referring to the RSK schematic, SW1 is connected to IRQ5 (PD6) and SW2 is connected to IRQ2 (P00).
SW3 is connected directly to the ADTRGONn and will be configured later in 84.4.4. Navigate to the ‘Interrupt
Controller Unit’ node in Code Generator and in the ‘General’ tab, configure these two interrupts as falling edge
triggered as shown in Figure 4-3 below.

Penpheral Funchons™
B GenenteCode | £ 0 B W E MW AEDODO BT E F G Mg 2

Fast interrupt setting

[ Fast intemupt BSC (BEUSERR vect=16)
Software interrupt setting
[ Software intemupt Level 15 (highest)
HMI setting
[] MM pin intemupt Falling Mo filter 0
IRGO setting
[ IRQOD P10 Nao filter 0
Low level Level 15 (highest)
IRG1 setting
O IRa1 P11 Nao filter 0
Lowi level Level 15 (highest)
|IRGZ setting
IRG2 Fin POO - Digital fiter Mo filter - (O
Valid edge  Falling - Prioity ~ Lewvel 15 (highest) -
|IRG3 setting
] IRG3 P24 Nao filter 0
Lowi level Level 15 (highest)
|IRG4 setting
] 1RG4 P01 Nao filter 0
Lowi level Level 15 (highest)
IRG5 setting
IRQE Fin PDE - Digital fiter Mo filter - (O
Valid edge  Falling - Prioity  Lewvel 15 (highest) -

Figure 4-3 Interrupt Functions tab
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RSKRX23T 4.  Code Generation Using the CS+ plug in

4.4.3 Compare Match Timer

Navigate to the ‘Compare Match Timer’ node in Code Generator. CMTO will be used as an interval timer for
generation of accurate delays. CMT1 and CMT2 will be used as timers in de-bouncing of switch interrupts.

In the ‘CMTO’ sub-tab configure CMTO as shown in Figure 4-4. This timer is configured to generate a High
priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for generating high

accuracy delays required in our application.

(=]l
S
"

L Property ‘fml Peripheral Functions™

] GenerateCode | 5 0 A 2 # W a% 5 S-8D 0 & D G DD D OL & F 7 F 0 G

CMTO | cMT1 | cMT2 | CMT3 |

Compare match timer operation setting
() Unused @ Used

m

Count clock setting -
@ PCLK/B @ PCLK/32 ) PCLK/128 © PCLK/512

Interval value setting
Interval value 1 ms » (Actual value: 1)
Interrupt setting

Enable compare match intermupt {CMIO)

Priority Level 10 -

Figure 4-4 CMTO tab

Navigate to the ‘CMT1’ sub-tab and configure CMT1 as shown in Figure 4-5. This timer is configured to
generate a High priority interrupt after 20ms. This timer is used as our short switch de-bounce timer later in

this tutorial.
Property | 5 Peripheral Functions® =B
‘[‘_;J Generate Code | & [0 & B #¢ £ g,ép ;j‘;f,; e Sl ‘3 173 CPE? 3, @ @ ;il El & & = ﬁ-|§ = RN '::

cMT0 || CMT1| cMT2 | cmT3 |
Compare match timer operation setting -
) Unused @ Used

Count clock setting
@ PCLK/8 @ PCLK/32 @ PCLK/128 i©) PCLK/512

Interval value setting
Interval value 20 ms »  (Actual value: 20)
Interrupt setting
[¥] Enable compare match intemupt {CMI1)

Priority Level 10 -

Figure 4-5 CMT1 tab

Navigate to the ‘CMT2’ sub-tab and configure CMT2 as shown in Figure 4-6. This timer is configured to
generate a High priority interrupt after 200ms. This timer is used as our long switch de-bounce timer later in

this tutorial.
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Property | 4 Peripheral Functions® =

f'_ij Generate Code |

L0EEPBEETBOODOADDBORRT T TR LS

"

“

CMTO | CMT1| CMT2 | cMT3 |

Ai‘

Compare match timer operation setting -

) Unused @ Used

m

- Count clock setting

) PCLK/8 ) PCLK/32

- Interval value setting

(@ PCLK/128

@ PCLK/512

Interval value

- Interrupt setting

ms w  (Actual value: 200.004267)

Enable compare match intemupt (CMI2)

Priority Level 10

Figure 4-6 CMT2 tab

4.4.4 12-bit A/D Converter

Navigate to the '12-bit A/D Converter’ tab in Code Generator. Refer to the screenshot shown in Figure 4-7,
Figure 4-8 and configure the S12AD as shown. We will be using the S12AD in 12-bit one shot mode on the
ANOOO input, which is connected to the RV1 potentiometer output on the RSK. The conversion start trigger

will be via the pin connected to SW3.
Peripheral Functions
5] GenerateCode @ %

O & s satddsTETF G Mm-S

-512a0 setting

) Unused

- Operation mode setting

@ Used

@ Single scan mode

() Group scan mode () Continuous scan mode

- Double trigger mode setting
@ Disable () Enable
— Self di is setting
Mode Unused -

Use VREFHOxD

- Disconnection detection assist setting
Charge setting

Unused -

2ADCLK

- Group scan priority setting

- AD converted value count setting

Group A without priority

Mot restarted or continued due to Group A pricrity

@ Addtion mode

() Average mode

- High-Potential reference voltage select
@ AVCCO

- Low-Potential reference voltage select

©) VREFHD

@ AVSS0

- Analog input channel setting

©) VREFLO

g
2
)
©
g
5
=

ANDOD
ANDOT

ANDOZ
ANDO3
ANDD4
ANDDS
ANDDE
ANDOD7
AND1E
ANDT7

Intemal reference voltage

e T

Convert {Group B Add/Average AD value  Dedicated sample and hold

= O

Figure 4-7 A/D Converter tab-1
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RSKRX23T 4.  Code Generation Using the CS+ plug in

— Conversion start trigger setting

Conversion start tigger (Group A)

AJD conversion start trigger pin -
Conversion start trigger (Group B)

Compare match with or input capture to MTUD. TGRA -
ADTRGO# pin selection PA4 -

— Data regi setting

AD converted value addition count 1-time conversion -
Nata plarement Right-alignment -
Automatic clearing Disable automatic clearing -

- Dedicated sample and held circuit setting

Input sampling time 8 | (us)  (Actual value: )

— AN0DD / Self-diagnosis conversion time setting
Input sampling time 3667 (ms)  (Actual value: 3.675)

— ANOD1 conversion time setting

I

Input sampling time |3.EET | (us)  (Actual value:

- ANOD2 conversion time setting

Input sampling time |3.EE? | (us)  (Actual value: 3.

e
T
I
7

- AN0D3 conversion time setting

t
o
I
n

Input sampling time |3.EE? | (us)  (Actual value: 3.

- ANOD4 conversion time setting

ta
T
|
)

Input sampling time |3.EE? | (us)  (Actual value: 3.

- ANDOS conversion time setting

w
=
|
b

Input sampling time |3 667 | (=) (Actual value:

- ANDDE conversion time setting

]

Input sampling time |3.BE? | (bs) (Actual value:

— ANDO7 conversion time setting

Input sampling time |3.EE? | () (Actual value:

a

- AND16 - AND17 conversion time setting

Input sampling time |3.EE? | (us)  (Actual value:

— Internal reference voltage conversion time setting

a

Input sampling time |5 | (ps) (Actual value:

— Conversion time setting
Total conversion time {Group A) 4725 (=)

Tatal conversion time {Group B) | (=)

{Mote: Continuous sampling is disabled)

— Output setting
ADSTO pin output enable 1 [Po2 -

~ Interrupt setting
Enable AD conversion end interrupt (S12AD1)

Priority Level 15 (highest) -

[/] Enable AD conversion end interrupt for group B (GBADI)

Priority | Level 15 (highest) - |

Figure 4-8 A/D Converter tab-2
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RSKRX23T 4.  Code Generation Using the CS+ plug in

4.45 Serial Communications Interface

Navigate to the ‘Serial Communications Interface’ tab in Code Generator, select the SCI5 sub-tab and apply
the settings shown in Figure 4-9. In the RSKRX23T SCI5 is used as an SPI master for the Pmod LCD on the
PMODL1 connector as shown in the schematic.

Peripheral Funcions
?Ej Generate Code | % [0 & # & L R EJ i .\z.-) @ & = o AT | sl 2

sci | sci5

General setting | Setting ‘

- Function setting

() Unused

) Asynchronous mode Transmission/reception
(") Asynchronous mode (Multi-processor) Transmission

I Clock synchronous mode Transmission

) Smart card interface mode Transmission
() Simple IIC bus
@ Simple SPlbus Master transmit only -

~ Pin setting
FB1
TXD5/5MO5I5/55DA5 PE5 -

Figure 4-9 SCI5 General Setting tab

Select the SCI5 ‘Setting’ sub-tab and configure the SPI Master as illustrated in Figure 4-10. Make sure the
‘Transfer direction setting’ is set to ‘MSB-first’ and the ‘Bit rate’ is set to 10000000. All other settings remain at
their defaults.
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RSKRX23T 4.  Code Generation Using the CS+ plug in

f] GenerateCode | 25 (O o8 4 1 #F s 5 0 & D D & J I T G Mg B
| sci1 | scis |
|Geneml sethngl S'Eﬁlﬂgl

- Transfer direction setting

() LSBHirst @ MSBirst
- Diata inversion setting

@ MNomnal () Inverted

~ Transfer rate setting

Transfer clock Internal clock - FPB7 -

Bit rate 10000000 - bps) (Actual value: 10000000, Emor : 0%)
[7] Enable modulation duty comection

SCKS5 pin function selection Clock output -
— Clock setting
Clock delay Clock is not delayed -

[] Enable clock polarity inversion

- Data handling setting

Transmit data handling Data handled in interrupt service routine -
- Interrupt setting
TXI5, TEIS priority Level 15 (highest) hd

—Callback function setting
Transmission end

Figure 4-10 SCI5 SPI Master Setting
Staying in the ‘Serial Communications Interface’ tab in Code Generator, select the SCI1 sub-tab and apply the

settings shown in Figure 4-11. In the RSKRX23T SCI1 is connected via a Renesas RL78/G1C to provide a
USB virtual COM port as shown in the schematic.

fo] GenerateCode | % O & @ I M 38 .5 0 @D O D £ 7 & F G o Mo =2

SCl | sci5

General setting | Setting ‘

- Function setting
) Unused
@ Asynchronous mode -Transmission.v'reoeption -
() Asynchronous mode (Mulii-processar) Transmission
(7 Clock synchronous mode Transmission
) Smart card interfface mode | Transmission
(7 Simple IIC bus
(") Simple SP1bus Slave transmit/receive
- Pin setting
RXD1/5MISO1/55CL1 PD5 -
TXD1/5MOSI1/55DA1 FD3 -
Figure 4-11 SCI1 General Setting tab
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RSKRX23T 4.  Code Generation Using the CS+ plug in

Select the SCI1 ‘Setting’ sub-tab and configure SCI1 as illustrated in Figure 4-12. Make sure the ‘Start bit
edge detection’ is set as ‘Falling edge on RXD1 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings
remain at their defaults.

‘@.]Generate{:ude ﬁQtﬂ"ﬁiﬁ-{#ﬁ%{ﬁ_@@@@yﬁnﬁnkfﬁ\uhdl,__\ﬂﬂu_ig:ﬁ
 SCIT | scis |

General setting | Setting |
- Start bit edge detection setting
) Low level on R¥D1 pin @ Falling edge on RXD1 pin

- Data length setting
) 9hbits @ B hits () 7 bits

- Panty setting
@ Mone () Even ) Odd

- Stop bit length setting

@ 1hit () 2hits
— Transfer direction setting
@ LSBirst (=) MSBirst
- Transfer rate setting
Transfer clock Internal clock - PD4
Bit rate 15200 - bps)  (Actual value: 15230765, Ermor: 0.16%)

[T] Enable modulation duty comection
SCK1 pin function SCK1 is not used -

- Noise filter setting
[7] Enable noise fiter

oize fitter clock Clock signal divided by 1 40000000 Hz

- Hardware flow control setting

@ Mone ) CTS ) RTS #

CTS1/RTS1 pin P02
- Diata handling setting

Transmit data handling Data handled in interrupt service routine -

Receive data handling Data handled in interrupt service routine -
— Interrupt setting

Enable emor intermupt (ERIT)

TXI, R¥I1, TEN, ERIT priority Level 15 (highest) -
- Callback function seting

Transmission end Reception end Reception emor

Figure 4-12 SCI1 Asynchronous Setting
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RSKRX23T 4.  Code Generation Using the CS+ plug in

4.4.6 I/O Ports

Referring to the RSK schematic, LEDO is connected to PA3, LED1 is connected to P71, LED2 is connected to
P72 and LED3 is connected to P73. Navigate to the ‘I/O Ports’ tab in Code Generator and configure these
four I/O lines as shown in Figure 4-13 and Figure 4-14 below. Ensure that the ‘Output 1’ tick box is checked.
This ensures that the code is generated to set LEDs initially off.

f] GenerateCode | 5 [0 & # = #F 38 o5 0 © D D & J & JF G o Mo 2
Portd | Port1 | Port2 | Port3 | Port4 | Port7 | Portg || Portd!| Port | PortD | PortE |

PA2
@ Unused @ In @ Out Pull-up CMOS output
PA3
() Unused @ In @ Out Pullyy CMOS output 4 Output 1 [] High-drive output
PA4
@ Unused @ h® © Ou Pull-up CMOS output
PAS
@ Unused @ In @ Out Pull-up CMOS output 5

Figure 4-13 1/O ports — PortA

?Ej Generate Code | = [ & #f & 3 G tg.z 43 @ ,;9 @ 2 P ;e R d A utg =
Port0 | Port1 | Port2 | Port3 | Ports | Bort7" | Ports | Porta | Ports | PortD | PoriE |

-P70
@ Unused ©In ) Out Pull-up CMOS output
-P71
) Unused D I @ Out Pull-up CMOS output - Output 1 High-drive output
-P72
) Unused @ In @ Out Pull-up CMOS output - Cutput 1
-P73
) Unused 7 In @ Out Pull-up CMOS output - Output 1 High-drive output
-P74
@ Unused D n ©) Out Pull-ug CMOS output
~-P75
@ Unused @ In © Out Pull-up CMOS output
-P76
@ Unused (@R ;] © Out Pull-ug CMOS output

Figure 4-14 1/O ports — Port7

P01 is used as one of the LCD control lines, together with P02, P91 and P92. Configure these lines as shown
in Figure 4-15,.Figure 4-16
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Peripheral Functions
%] GenerateCode | % O & # - M 50 5 0 B D D & F I JF G o Mo B

 Port0 | Port1 | Port2 | Port3 | Port4 | Port7 | Port9 | Porta | PortB | PortD | PortE |
-PO0

@Unused Ot ©0u CMOS output ' High-drive
-PO1
) Unused @ In @ Out CMOS output - Output 1 [ High-drive output
-P02
) Unused @ In @ Out ll-up CMOS output - Output 1 [ High-drive output
Figure 4-15 1/O ports — Port0
Peripheral Funchions
%] GenerateCode | 25 [ & @ = ¥ 38 % G O D O & T & T G0 9 Mg 23

Portd | Port1 | Port2 | Port3 | Ports | Port7 || Bortd || Porta | PortB | PortD | PortE |

“Po1
() Unused © In @ Out CMOS output - Output 1 [7] High-drive output
-P92
) Unused @ In @ Out Pull-up CMOS output - [] Output 1 [] High-drive output
-P33
@ Unused @ In ) Out P | CMOS output E Hig e
P34
@ Unused © In ) Out P CMOS cutput Hig .

Figure 4-16 1/O ports — Port9

Peripheral function configuration is now complete. Save the project using the File -> Save Project menu item,
then click ‘Generate Code’. The Output pane should report ‘The operation of generating file was successful’,
as shown Figure 4-17 below.
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RSKRX23T 4.  Code Generation Using the CS+ plug in

Output

[X]

M0405002:The generating source folder is: C:\wnrkspace\CG_Iutcrial\J
M0409001:The following files were genera:ed:d
M0409004:cg_srchr_cg main.c was nve:written‘g
M0403004:cg_src\r_cg_dbsct.c was uverwritten.g
M0405004:cg_srchr_cg intprg.c was nverwritten_g
M0405004:cg_srch\r_cg _resetprg.c was nverwritten_g
M04059004:cg_srchr_cg sbrk.c was nverwzitten.J
M0403004:cg_srch\r_cg_vecttbl.c was cverwrittenyg
M0403004:cg_src\r_cg_sbrk.h was uverwristen.g
M0403004:cg_srch\r_cg_stacksct.h was averwritten.g
M0409004:cg_srehr_cg vect.h was nverwzitten.g
M0405004:cg_srch\r_cg hardware setup.c was Dverwritten.g
M0409004:-cg_srchr cg macrodriver.h was Dverwritten.d
M0409004:cg_srch\r_cg_userdefine. h was nverwritten_g
M0408004:cg_src\r_cg_cgc.c was overwzitcen.g
M0409004:cg_sreh\r_cg cgc _user.c was averwritten.g
M0409004:cg_srehr_cg cge.h was cverwritten_g
M0409004:cg_srchr_cg icu.c was nverwritten.ﬂ
M0409004:cg_srchr_cg_icu user._c was nvezwritten_g
M0409004:-eg_srchr_cg icu.h was Dverwritten.g
M0403000:cg_srchr_cg port.c was generated_g
M0409000:cg_srch\r_cg port_user.c was generatedAd
M0403000:cg_srch\r_cg_port.h was gene:ated.g
M0409004:cg_srch\r_cg_cmt.c was ove:w:itten.g
M0403004:cg_src\r_cg_cmt_user.c was uverwritten_g
M0408004:cg_srchr_cg cmt_h was nverwritten_g
M04059000:cg_srch\r_cg sci.c was generated.g
M0405000:cg_srch\r_cg sci_user.c was generated_d
M0409000:cg_srchr_cg sci.h was generated_g
M0403004:cg_src\r_cg_slZad.c was overwzitten.g
M0409004:cg_srehr_eg sl2ad user.c was overwritten-Q
M0409004:cg_srehr_eg slZad.h was nverwritten-d
HM04053003:The operation of generating file was successful_J

[EQF]

~

m

All Messages 1 *Code Generator ,( *Rapid Build /

Figure 4-17 Code generator console

Figure 4-18 shows the Code Generator Files in the Project Tree pane. In the next section the CG_Tutorial
project will be completed by adding user code into these files and adding new source files to the project.
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Project Tree o

: @ 2| [E

am CG Tutorial (Project)
ﬁ R5F523T5AxFM (Microcontroller)
EE! Code Generator (Design Tool)
4y, CC-RX (Build Tool)
r:",a\ RX Simulator (Debug Tool)
-3 File

5 'ﬂ; Build tool generated files

h-| iodefine.h

B{‘D Code Generator

t-Bo] r_cg_main.c

?J r_cg_dbsct.c

& r_cg_intprg.c

& r_cg_resetprg.c

& r_cg_sbrk.c

g r_cg_vecttbl.c

‘_?3 r_cg_hardware_setup.c

& r_cg_cgec

& r_cg_cgc_user.c

& reg icuc

..... & r_cg_icu_user.c

..... & | r_cg_port.c
‘fJ r_cg_port_user.c

& r_cg_emt.c

| r_cg_cmt_user.c

gﬂ r_cg_sci.c

‘f_l r_cg_sci_user.c
& r_cg_sl2ad.c

Figure 4-18 Code Generator Files in the Project Tree
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5. Completing the Tutorial Project

5. Completing the Tutorial Project

5.1

Project Settings

A, CC-RX Property

e In the ‘Project Tree’' pane, select | > - =
‘CC-RX (Build Tool). The build LR DefautBuid
. . . . 4
properties will appear in the main Instction set archilectuas b2 architecturelsamn2)
. Uzes floating-paint. operation instructions Yes|-fpu)
WIndOW Endian typegfnpr data ’ L\llla—:ndian datal-endian=little)
. . Rounding method for floating-point constant operations round to nearest-raund=nearest)
] CS+ creates a Slngle bulld Handling of denomalized numbers in foating-point constants Handles as zeros|-denormalize=off]
. . ¢ T Precision of the double type and long double type Handles in single precision|-dbl_size=4]
configuration called ‘Default Build Replaces th i pa with e sho ype. .
for the project. This has standard St o hsebe e
imi I Selects the enumeration type size automaticall Mo
COde Optl m IS&tIOﬂ turned on by Order of bit-field members 4 ' Allacates from right{-bit_order=right)
Assumes the boundary alignment value far structure members is 1 No[-unpack)
erault.
Enables C++ exceptional handling function [try, catch and throw)] Mo[-nioexception)
Enables the Ct+ exceptional handing function (dynamic_cast and typeid) Mo tti=off)
General registers used only in fast intermupt functions None{-fint_register=0]
Branch width size Compiles within 24 bits(-branch=24)
Base register for ROM None
Base register for RahM None
Address value of base register that sets the address value 00000000
Register of baze register that sets the address value None
Build mode
Selects the build mode name to be uzed during build,
e Select the ‘Compile Options’ tab at | °“'°" s . £99(1ang-cS8)
. . ariguage of § rce file -lang=c
the bottom of the properties window Lanquage of the Ce+ source fle CiCoSanga)
pane_ Under ‘Language Of the C > Additional include paths C
HPN] f _ f > System include paths pa
source flle SeleCt ng('lang_cgg) > Include files at the head of compiling units Include files at the head of con
as shown opposite_ > Macro definition Macro defirition[0]
Irealidates the oredefined macro
e Select the ‘Link Options’ tab at the | ¢ Optimization y y
b f th ti ind Optimization type Mo optimize[-MOO0Ptimize)
ottom of the properties Window | , section
. - Section start address B_1.R_1B_2R_2B.R.5U.51/04 PResetPRGAOFFFFE000,C_1.C
ane. Under ‘Section -> ROM to
i ’ > The specified zection that outputz  The specified section that outputs externally defined symbolz to th
RAM mapped section’, add the Lo spee i 0
. > Sechion alignment echion alignment
three.  mappings as  shown ROM to REM mappe ROM to RAM mapped section[3] =
OppOSIte. 1] D=R
1] D_1=R_1
[2] D=k &
. Thes_e settings are easily added _by Text Edit B
clicking the button *..." and pasting Text
the following text into the dialog: =
D_1=R_1
D_2=R_2
D=R
D 1=R 1
D 2=R 2
e This ensures that the linker assigns
RAM rather than ROM addresses
to C variables.
4 b
0K || Cancsl || e
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=

e From the ‘_BU|Id’ r’nenu_, se‘lect ‘_Bmldl Build Mode Settings @
Mode Settings...’. Click ‘Duplicate
and in the resulting ‘Character Selected buid mode:
String Input’ dialog, enter ‘Debug’ |
for the name of the duplicate build

mode. Build mode list:

e

e The new ‘Debug.’ build mO(_:ie will _be A, CC-RY Propetty E][
added to the Build mode list. Click 2 Build Mode
‘Close’. Now, in the main CC-RX (Buildmode e =
Property window, under the 4 OutputFile Type and Path
‘Common Options’ tab, click on the Output file type
line containing ‘Build Mode’, click Intermediate file output folder

the pull-down arrow and select
‘Debug’ from the pull-down’.

e Inthe ‘Frequently Used Options (for | A comxPropert @ (& =

) s 4 BuildMode
Compile) group, select the Build mode Debug

‘Optimization Level’ option and b CPU

select ‘0O’ from the pull-down. We | | " PIC/FD
4 Output File Type andPath

ha.Ve now Created a ‘Debug, bu"d Output file type Execute Module[Load Module File]
mode W|th no Code Optimisation Intermediate file output folder #Buildd adeM ame?;
. . . 4 Frequently Used Options{for Compie]
and will be using the Build mode to b Addtional include paths Additional include paths[2]
create and debug the project. [+ Syztem include paths System include paths[0]
> Macro definition Macro definition[0]

Outputs debugging information “Y'es[-debug]
Optimization level 0[-optimize=0) El

Outputs additional information for inter-module optimization
Optinization type 1[-optimize=1]
Outputs a zource list file 2[-optimize=2)
4 Frequently Used Options(for Assemble] Mz -optimize=rmax)
R20UT3321EG0100 Rev. 1.00 RENESAS Page 26 of 53
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e All of the sample code projects | % CCAFuopet @) (& =l
contained in this RSK are | < BuldMode Debug
configured with three Build modes; . CPU
‘DefaultBuild’, ‘Debug’ and | v PIC/AD
. , . - . 4 OutputFile Type andPath
Release . Release IS Created n Output file type Execute ModulelLoad Module File)
the same way as above; by Intermediate file output f_older #BuildModeMames;
d | t ‘D f |t B ld, 4 F Iy Used Opt [for Compile]
uplicating €rau uila-. » mddtional include paths Additional include paths[2]
‘Release' bulld mOde |ea.VeS Code > System include paths System include paths[0]
P . > Macro definition M acro definition[0]
Optlm Isation turned O_n and Outputs debugging information Hol[-nodebug])
removes debug information from Dptimization level
the OUtpUt flle Outputs additional information for inter-module optimization
. Optimization type - TPTIZES TS
 To remove debug information from | Dumee e e o Assonti) LT
the ‘Release’ build mode, in the » Addtional include paths ) Additional include paths [0]
‘CC_RX Property’ WindOW SeleCt > System include paths System include paths [0]
. . , ! > Macro definition I acro definition [0]
the ‘Common Options’ tab at the 4 Frequently Used Options(for Link)
bottom Of the WindOW pane_ For > Using libraries Using libraries{0]
B . . . y Outputs debugging inf i es [Outputs to the output file]-DEB
the ‘Outputs debugging information i atei e e kDRl

option, select ‘No(-nodebug). Outputs debugging infomation

Selects whether to output debugging information.
° Reset the bUI|d mOde baCk tO Thiz comesponds to the -debug and -nodebug options of the compiler.
‘Debug’ using the ‘Build Mode’ pull-
down control.

e From the menus, select ‘File ->
Save AlI' to save all project
settings.

52 Additional Folders

m CG_Tutorial - C5+ for CC - [Project Tree]
File Edit View Project Build Debug Tool Window Help

e Before new source files are added
to the project, we will create two _ e
additional folders in the CS+ | @set L H@ X o0 9 & &2 & >
Project Tree. O P23 8 g

e In the Project Tree pane, right-click | SEEiiis ¢ X

A

the CG_Tutorial project and select | ? @ S [
‘Add -> Add New Category'. 2 ‘W‘
&l

Build CG_Tutorial
] Rebuild CG_Tutorial

A .4 Clean CG_Tutorial
Bj D_t} Open Folder with Explorer

Bl Windows Explorer Menu
| Add 4 | +f; Add Subproject..,

ff4 SetCG_Tutorial as Active Project +f; Add New Subproject...

[i7 Save Project and Development Tools as Package... _:', Add File...

Crl+V ]| Add New File...
k2 |[1) Add New Category
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Aug 24, 2015




RSKRX23T

5. Completing the Tutorial Project

e Rename the newly-created ‘New
Category’ folder to ‘C Source Files'.
Repeat these steps to create a new
category folder for ‘Dependencies’.

=13 CG Tutorial (Project)®
o {E, RSF523T54xFM (Microcontroller)

;~I Code Generator (Design Toel)
..... 4o, CC-RX (Build Tool)
L2l RX Simulater (Debug Tool)

=[P File

ﬂ Build tool generated files

.| iodefine.h

|_]_ Code Generator

e |_]_ C Source Files
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5.3 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSK. Refer to the Tutorial project folder
created according to the Quick Start Guide procedure. Locate the files ascii.h, r_okaya lIcd.h, iodefine.h,
ascii.c, and r_okaya_lcd.c in this folder. Copy these files into the C:\Workspace\CG_Tutorial folder.

e Right-click on the ‘C Source Files’ | -3 File
in the Project Tree and select ‘Add - £ Build tool generated files
> Add File...’. | Code Generator

e Browse to the files ascii.c, and i....]) Dependen Add 3 Addrie.

r_okaya_lcd.c in the B Ooen Folder with Exol #] Add New Fil

H Ulpen Folder with exXplorer ™ ew rile...

C:\Workspace\CG_Tutorial  folder s —pen rolderwiih Spors _

and click ‘Add’ =) Windows Explorer Menu 1) Add New Category
e Repeat the above steps to add the & Remove from Project  Shift+Del

iles ascii.h , r_okaya_lcd.h to the iy Copy Ctrl+C

fil h , r_okaya lIcd.h to th 3 Copy

‘Dependencies’ folder. &l paste Cirl+V

e Repeat the above steps to add the
file iodefine.h to the ‘File’ folder.

Code must be inserted in to the user code area in many files in this project, in the areas delimited by
comments as follows:

/* Start user code for _xxxxx_. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Where _xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Code Generator, if the user needs to subsequently change any of the Code Generator-generated code.

In the CS+ Project Tree, expand the ‘Code Generator’ folder and open the file ‘r_cg_userdefine.h’ by double-
clicking on it. Insert the following #defines in between the user code delimiter comments as shown below.
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/* Start user code for function. Do not edit comment generated here */
#define TRUE @)

#define FALSE ()

/* End user code. Do not edit comment generated here */

In the CS+ Project Tree, open the file ‘r_cg_main.c’ by double-clicking on it. Insert #include "r_okaya_lcd.h" in
between the user code delimiter comments as shown below.

/* Start user code for include. Do not edit comment generated here */
#include "r_okaya lcd.h"
/* End user code. Do not edit comment generated here */

Scroll down to the ‘main()’ function and insert the highlighted code as shown below into the beginning of the
user code area of the main() function:

void main(void)

{
R_MAIN_UserlInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the debug LCD */
R_LCD_InitQ);
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)' RSKRX23T ™);
R_LCD_Display(1l, (uint8_t *)" Tutorial ");
R_LCD_Display(2, (uint8_t *)" Press Any Switch ");
while (1U)
{
/* End user code. Do not edit comment generated here */
3
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5.3.1 SPI Code

The Okaya LCD display is driven by the SPI Master that was configured using Code Generator in §84.4.5. In
the CS+ Project Tree, open the file ‘r_cg_sci.h’ by double-clicking on it. Insert the following code in the user
code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */
MD_STATUS R_SCI5_SPIMasterTransmit(uint8 t * const tx_buf, const uintl6_t tx_num);
/* End user code. Do not edit comment generated here */

Now, open the r_cg_sci_user.c file and insert the following code in the user area for global:

/* Start user code for global. Do not edit comment generated here */
/* Flag used locally to detect transmission complete */

static volatile uint8_t sci5_txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmitend call-back function for SCI5:

static void r_sci5_callback_transmitend(void)

/* Start user code. Do not edit comment generated here */
sci5_txdone = TRUE;
/* End user code. Do not edit comment generated here */

}

Now insert the following function in the user code area at the end of the file:

/

* Function Name: R_SCI5_SPIMasterTransmit

* Description : This function sends SPI5 data to slave device.
* Arguments : tx_buf -

* transfer buffer pointer

* t>x_num -

* buffer size

* Return Value : status -

*

MD_OK or MD_ARGERROR

/
MD_STATUS R_SCI5_SPIMasterTransmit (uint8_t * const tx_buf, const uintl6_t tx_num)

{
MD_STATUS status = MD_OK;

/* clear the flag before initiating a new transmission */
sci5_txdone = FALSE;

/* Send the data using the APlI */
status = R_SCI5_SPI1_Master_Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == sci5_txdone)

/* Wait */
}

return (status);

* N

End of function R_SCI5 SPIMasterTransmit

/

This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD, and is used as the main API call in the LCD code module.
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5.3.2 CMT Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Code Generator in 84.4.3. Open the file r_cg_cmth
and insert the following code in the user area for function at the end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_CMT_MsDelay(const uintl6_t millisec);
/* End user code. Do not edit comment generated here */

Open the file r_cg_cmt_user.c and insert the following code in the user area for global at the beginning of the
file:

/* Start user code for global. Do not edit comment generated here */
static volatile uint8_t one_ms_delay complete = FALSE;
/* End user code. Do not edit comment generated here */

Scroll down to the r_cmt_cmiO_interrupt() function and insert the following line in the user code area:

static void r_cmt_cmiO_interrupt(void)

{
/* Start user code. Do not edit comment generated here */
one_ms_delay_complete = TRUE;
/* End user code. Do not edit comment generated here */
3

Then insert the following function in the user code area at the end of the file:

Function Name: R_CMT_MsDelay

Description : Uses CMTO to wait for a specified number of milliseconds
Arguments : uintlé_t millisecs, number of milliseconds to wait
Return Value : None

X X ok T~

void R_CMT_MsDelay (const uintl6_t millisec)
uintl6é_t ms_count = O;

do
{
R_CMTO_Start();
while (FALSE == one_ms_delay_complete)

{
/* Wait */

(o)

R_CMTO_Stop();
one_ms_delay complete = FALSE;
ms_count++;

3} while (ms_count < millisec);

3
/

End of function R_CMT_MsDelay

/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in 86. The program will display ‘RSKRX23T
Tutorial Press Any Switch on 3 lines in the LCD display.
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5.4 Switch Code Integration

API functions for user switch control are provided with the RSK. Refer to the Tutorial project folder created
according to the Quick Start Guide procedure. Locate the files rskrx23tdef.h, r_rsk switch.h and
r_rsk_switch.c in this folder. Copy these files into the C:\Workspace\CG_Tutorial folder. Import these three
files into the project in the same way as the LCD files.

The switch code uses interrupt code in the files r_cg_icu.h, r_cg_icu.c and r_cg_icu_user.c and timer code in
the files r_cg_cmt.h, r_cg_cmt.c and r_cg_cmt_user.c, as described in 84.4.2 and 84.4.3. It is necessary to
provide additional user code in these files to implement the switch press/release detection and de-bouncing
required by the API functions in r_rsk_switch.c.

54.1 Interrupt Code

In the CS+ Project Tree, expand the ‘Code Generator’ folder and open the file ‘r_cg_icu.h’ by double-clicking
on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU_IRQ */
uint8_t R_ICU_IRQIsFallingEdge(const uint8_t irg_no);

void R_ICU_IRQSetFallingEdge(const uint8_t irg_no, const uint8_t set_f_edge);
void R_ICU_IRQSetRisingEdge(const uint8_t irg_no, const uint8_t set_r_edge);

/* End user code. Do not edit comment generated here */
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Now, open the r_cg_icu.c file and insert the following code in the user code area at the end of the file:

Function Name: R_ICU_IRQIsFallingEdge

Description : This function returns 1 if the specified ICU_IRQ is set to
falling edge triggered, otherwise O.

Arguments  uint8_t irg_no

Return Value : 1 if falling edge triggered, O if not

o oX X XN

uint8_t R_ICU_IRQIsFallingEdge (const uint8_t irg_no)
{
uint8_t falling_edge_trig = 0xO0;
iT (ICU.IRQCR[irg_no]-BYTE & _04 I1CU_IRQ_EDGE_FALLING)

falling_edge_trig = 1;
3

return falling_edge_trig;

N

End of function R_ICU_IRQIsFallingEdge

Function Name: R_ICU_IRQSetFallingEdge

Description : This function sets/clears the falling edge trigger for the
specified ICU_IRQ.

Arguments : uint8_t irg_no
uint8_t set_f edge, 1 if setting falling edge triggered, O if
clearing

Return Value : None

*ox % ok o XN

/
void R_ICU_IRQSetFallingEdge (const uint8_t irg_no, const uint8_ t set f_edge)

ifT (1 == set_T _edge)
ICU. IRQCR[irg_no].BYTE |= _04 ICU_IRQ_EDGE_FALLING;
}

else

ICU. IRQCR[irg_no].BYTE &= (uint8_t) ~ 04 ICU_IRQ EDGE_FALLING;
}

}
/
* End of function R_ICU_IRQSetFallingEdge

Function Name: R_ICU_IRQSetRisingEdge

Description : This function sets/clear the rising edge trigger for the
specified ICU_IRQ.

Arguments  uint8_t irg_no
uint8_t set_r_edge, 1 if setting rising edge triggered, O if
clearing

Return Value : None

ook X X % X F N\

void R_ICU_IRQSetRisingEdge (const uint8_t irg_no, const uint8_t set_r_edge)
if (1 == set_r_edge)
ICU. IRQCR[irg_no].BYTE |= _08_ICU_IRQ EDGE RISING;
}

else

ICU. IRQCR[irg_no].BYTE &= (uint8_t) ~_08_ICU_IRQ_EDGE_RISING;

* NS

End of function R_ICU_IRQSetRisingEdge
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Open the r_cg_icu_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Defines switch callback functions required by interrupt handlers */
#include "r_rsk_switch.h"

In the same file insert the following code in the user code area inside the function r_icu_irg2_interrupt ():

/* Switch 2 callback handler */
R_SWITCH_IsrCallback2();

In the same file insert the following code in the user code area inside the function r_icu_irg5_interrupt ():

/* Switch 1 callback handler */
R_SWITCH_IsrCallbackl1();

5.4.2 De-bounce Timer Code

Open the r_cg_cmt_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Defines switch callback functions required by interrupt handlers */
#include "r_rsk_switch.h"

In the same file insert the following code in the user code area inside the function r_cmt_cmil_interrupt ():

/* Stop this timer - we start it again in the de-bounce routines */
R_CMT1_Stop(Q);

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelsrCallback();

In the same file insert the following code in the user code area inside the function r_cmt_cmi2_interrupt ():

/* Stop this timer - we start it again in the de-bounce routines */
R_CMT2_Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelsrCal lback();

5.4.3 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In 84.4.4, we configured the ADC to be triggered from the ADTRGO# pin, SW3. In this
code, we also perform software triggered A/D conversion from the user switches SW1 and SW2, by
reconfiguring the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the CS+ Project Tree, expand the ‘Code Generator’ folder and open the file ‘r_cg_userdefine.h’ by double-
clicking on it. Insert the following code the user code area, resulting in the code shown below

/* Start user code for function. Do not edit comment generated here */
#define TRUE (¢D)
#define FALSE )

extern volatile uint8_t g_adc_trigger;
/* End user code. Do not edit comment generated here */
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Open the file ‘'r_cg_main.c’ and insert #include "r_rsk_switch.h" in the user code area for include, resulting in
the code shown below:

/* Start user code for include. Do not edit comment generated here */
#include "r_okaya_lcd.h"

#include "r_rsk_switch.h"

/* End user code. Do not edit comment generated here */

Next add the switch module initialization function call highlighted in the user code area inside the main()
function, resulting in the code shown below:

void main(void)

R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */

/* Initialize the switch module */
R_SWITCH_InitQ);

/* Initialize the debug LCD */
R_LCD_InitQ);

/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)"™ RSKRX23T ");

R_LCD Display(1, (uint8_t *)'" Tutorial ");
R_LCD_Display(2, (uint8_t *)" Press Any Switch ");
while (1U)

/* End user code. Do not edit comment generated here */

¥
In the same file, insert the declarations in the user code area for global, resulting in the code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Prototype declaration for cb_switch _press */
static void cb_switch_press (void);

/* Prototype declaration for get _adc */
static uintl6_t get_adc(void);

/* Prototype declaration for lcd_display_adc */
static void lcd_display adc (const uintl6_t adc_result);

/* Variable for flagging user requested ADC conversion */
volatile uint8_t g_adc_trigger = FALSE;

/* End user code. Do not edit comment generated here */
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Next add the highlighted code below in the user code area inside the main() function and the code inside the
while loop, resulting in the code shown below:

void main(void)

{

}

R_MAIN_UserlInit(Q);
/* Start user code. Do not edit comment generated here */

/* Initialize the switch module */
R_SWITCH_Init();

/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCal lback(cb_switch_press);

/* Initialize the debug LCD */
R_LCD_Init Q;

/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)" RSKRX23T '");

R_LCD Display(1l, (uint8_t *)" Tutorial ");
R_LCD_Display(2, (uint8_t *)" Press Any Switch ");

/* Start the A/D converter */
R_S12AD_Start();

while (1U)
uintlé_t adc_result;

/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g_adc_trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get_adc();

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Reset the flag */
g_adc_trigger = FALSE;

by

/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */

else if (TRUE == g_adc_complete)

{
/* Get the result of the A/D conversion */
R_S12AD_Get_ValueResult(ADCHANNELO, &adc_result);
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Reset the flag */
g_adc_complete = FALSE;

by

else
/* do nothing */

by

/* End user code. Do not edit comment generated here */

Then add the definition for the switch call-back, get_adc() and Icd_display_adc() functions in the user code
area for adding at the end of the file, as shown below:

/
* Function Name : cb_switch_press
* Description : Switch press callback function. Sets g_adc_trigger flag.
* Argument I none
* Return value : none
/

static void cb_switch_press (void)
{

/* Check if switch 1 or 2 was pressed */

if (g_switch_flag & (SWITCHPRESS_1 | SWITCHPRESS_2))

{
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/* set the flag indicating a user requested A/D conversion is required */
g_adc_trigger = TRUE;

/* Clear flag */
g_switch_flag = 0x0;
}

3
/

* End of function cb_switch_press

Function Name : get_adc

Description : Reads the ADC result, converts it to a string and displays
it on the LCD panel.

Argument : none

Return value : uintl6_t adc value

FooE X X XN

static uintl6_t get_adc (void)

{
/* A variable to retrieve the adc result */
uintl6_t adc_result;

/* Stop the A/D converter being triggered from the pin ADTRGOn */
R_S12AD_Stop();

/* Start a conversion */
R_S12AD_SWTriggerStart();

/* Wait for the A/D conversion to complete */
while (FALSE == g_adc_complete)
{

/* Wait */
}

/* Stop conversion */
R_S12AD_SWTriggerStop();

/* Clear ADC flag */
g_adc_complete = FALSE;

R_S12AD_Get_ValueResult(ADCHANNELO, &adc_result);

/* Set AD conversion start trigger source back to ADTRGOn pin */
R_S12AD_Start();

return adc_result;

N

End of function get_adc

Function Name : lcd_display_adc

Description : Converts adc result to a string and displays
it on the LCD panel.

Argument : uintl6_t adc result

Return value : none

R OX X XN

static void lcd_display_adc (const uintl6_t adc_result)

{
/* Declare a temporary variable */
uint8_t a;

/* Declare temporary character string */
char lcd_buffer[11] = " ADC: XXXH";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (uint8_t)((adc_result & 0x0F00) >> 8);

Icd_buffer[6] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

a = (uint8_t)((adc_result & 0x00F0) >> 4);

lcd_buffer[7] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a = (uint8_t)(adc_result & 0x000F);
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Icd_buffer[8] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

/* Display the contents of the local string lcd_buffer */
R_LCD_Display(3, (uint8_t *)lcd_buffer);

N

End of function lcd_display_adc

V4

Open the file ‘r_cg_s12ad.h’ by double-clicking on it. Insert the following code in the user code area for

function, resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8_t g_adc_complete;

/* Functions for starting and stopping software triggered A/D conversion */

void R_S12AD_SWTriggerStart(void);
void R_S12AD_SWTriggerStop(void);
/* End user code. Do not edit comment generated here */

Open the file ‘r_cg_sl12ad.c’ by double-clicking on it. Insert the following code in the user code area for

adding at the end of the file, resulting in the code shown below:

/* Start user code for adding. Do not edit comment generated here */

/
* Function Name: R_S12AD SWTriggerStart
* Description : This function starts the AD converter.
* Arguments : None
* Return Value : None
/
void R_S12AD_SWTriggerStart(void)
{
IR(S12AD, S12ADI1) = 0U;
IEN(S12AD, S12ADI1) = 1U;
S12AD.ADCSR.BIT.ADST = 1U;
3
/
End of function R_S12AD SWTriggerStart
/
/
* Function Name: R_S12AD_SWTriggerStop
* Description : This function stops the AD converter.
* Arguments : None

* Return Value : None

void R_S12AD_SWTriggerStop(void)
S12AD.ADCSR.BIT.ADST = 0U;
1EN(S12AD, S12ADI1) = 0U;

IR(S12AD, S12ADI) = OU;
b4

/
End of function R_S12AD_SWTriggerStop

/* End user code. Do not edit comment generated here */
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Open the file r_cg_sl12ad_user.c and insert the following code in the user code area for global, resulting in the
code shown below:

/* Start user code for global. Do not edit comment generated here */
/* Flag indicates when A/D conversion is complete */

volatile uint8_t g_adc_complete;

/* End user code. Do not edit comment generated here */

Insert the following code in the user code area of the r_s12ad_interrupt () function, resulting in the code shown
below:

static void r_sl2ad_interrupt(void)

/* Start user code. Do not edit comment generated here */
g_adc_complete = TRUE;
/* End user code. Do not edit comment generated here */

}

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in 86. When any switch is pressed, the
program will perform an A/D conversion of the voltage level on the ADPOT line and display the result on the
LCD panel. Return to this point in the CG_Tutorial to add the UART user code.
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5.5 Debug Code Integration

API functions for trace debugging via the RSK serial port are provided with the RSK. Refer to the Tutorial
project folder created according to the Quick Start Guide procedure. Locate the files r_rsk_debug.h and
r_rsk_debug.c in this folder. Copy these files into the C:\Workspace\CG_Tutorial folder. Import these two files
into the project in the same way as the LCD files.

In the r_rsk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL_DEBUG_WRITE (R_SCI1_AsyncTransmit)

This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.

5.6 UART Code Integration

5.6.1 SCI Code

In the CS+ Project Tree, expand the ‘Code Generator’ folder and open the file ‘r_cg_sci.h’ by double-clicking
on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */

MD_STATUS R_SCI5_SPIMasterTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);

MD_STATUS R_SCI1_AsyncTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);

/* Character is used to receive key presses from PC terminal */
extern uint8_t g_rx_char;

/* Flag used to control transmission to PC terminal */
extern volatile uint8_t g_tx flag;

/* End user code. Do not edit comment generated here */

Open the file ‘r_cg_sci_user.c. Insert the following code in the user area for global near the beginning of the
file:

/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8_t g_rx_char;

/* Flag used to control transmission to PC terminal */
volatile uint8_t g_tx_flag = FALSE;

/* Flag used locally to detect transmission complete */
static volatile uint8_t sci5_txdone;
static volatile uint8_t scil_txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the r_scil_callback transmitend()
function:

static void r_scil_callback_transmitend(void)

{
/* Start user code. Do not edit comment generated here */
scil_txdone = TRUE;
/* End user code. Do not edit comment generated here */
3
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In the same file, insert the following code in the user code area inside the r_scil_callback_receiveend()

function:

static void r_scil_callback_receiveend(void)

{

/* Start user code. Do not edit comment generated here */
/* Check the contents of g_rx _char */
iIf (("c” == g_rx_char) || (°C" == g_rx_char))

g_adc_trigger = TRUE;
by

/* Set up SCI1 receive buffer and callback function again */
R_SCI11_Serial_Receive((uint8_t *)&g_rx_char, 1);

/* End user code. Do not edit comment generated here */

}

At the end of the file, in the user code area for adding, add the following function definition:

Function Name: R_SCI1_AsyncTransmit
Description : This function sends SCI1 data and waits for the transmit end flag.
Arguments - tx_buf -

transfer buffer pointer

t>x_num -

buffer size
Return Value : status -

MD_OK or MD_ARGERROR

ok X X X X Ok XN\

/
MD_STATUS R_SCI1_AsyncTransmit (uint8_t * const tx_buf, const uintl6_t tx_num)

{
MD_STATUS status = MD_OK;

/* clear the flag before initiating a new transmission */
scil_txdone = FALSE;

/* Send the data using the APlI */
status = R_SCI1_Serial_Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == scil_txdone)

/* Wait */

return (status);

}

/
* End of function R_SCI1_AsyncTransmit
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5.6.2 Main UART code

Open the file ‘r_cg_main.c’. Add the following declaration to the user code area for include near the top of the
file:

#include "r_rsk_debug.h"
Add the following declaration to the user code area for global near the top of the file:

/* Prototype declaration for uart_display_adc */
static void uart_display adc(const uint8_t adc_count, const uintl6_t adc_result);

/* Variable to store the A/D conversion count for user display */
static uint8_t adc_count = 0;

Add the following highlighted code to the user code area in the main function:

void main(void)

{
R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the switch module */
R_SWITCH_InitQ);
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCal lback(cb_switch_press);
/* Initialize the debug LCD */
R_LCD_Init Q;
/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8_t *)" RSKRX23T ");
R_LCD Display(1, (uint8_t *)" Tutorial ");
R_LCD Display(2, (uint8_t *)" Press Any Switch ");
/* Start the A/D converter */
R_S12AD_Start();
/* Set up SCI1 receive buffer and callback function */
R_SC11_Serial_Receive((uint8_t *)&g_rx_char, 1);
/* Enable SCI1 operations */
R_SCI1_Start();
while (1U)
{
uintl6é_t adc_result;
/* Wait for user requested A/D conversion flag to be set */
if (TRUE == g_adc_trigger)
{
/* Call the function to perform an A/D conversion */
adc_result = get_adc();
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Increment the adc_count */
if (16 == ++adc_count)
{
adc_count = 0;
}
/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);
/* Reset the flag */
g_adc_trigger = FALSE;
3
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/*

SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */

else if (TRUE == g_adc_complete)

{

h
els

}

h
/* End
H

/* Get the result of the A/D conversion */
R_S12AD_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count */
if (16 == ++adc_count)
{

3

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

adc_count = 0;

/* Reset the flag */
g_adc_complete = FALSE;

e

/* do nothing */

user code. Do not edit comment generated here */

Then, add the following function definition in the user code area at the end of the file:

Function

Argument

o oX X XN

Description

Name : uart_display_adc

: uint8_t : adc_count
uintl6é_t: adc result

Return value : none

: Converts adc result to a string and sends it to the UARTL.

static void uart_display_adc (const uint8_t adc_count, const uintl6_t adc_result)

{

/* Declare a temporary variable */

char a;

/* Declare temporary character string */
static char uart_buffer[] = "ADC xH Value: xxxH\r\n";

/* Convert ADC result into a character string, and store in the

Cast

ing to ensure use of correct data type. */

a = (char)(adc_count & 0x000F);

uart_buffer[4] = (char)((a < 0x0A) ? (a + 0x30)

a = (char)((adc_result & 0OxOF00) >> 8);

uart_buffer[14] = (char)((a < 0x0A) ? (a + 0x30)

a = (char)((adc_result & 0x00F0) >> 4);

uvart_buffer[15] = (char)((a < 0x0A) ? (a + 0x30)

a = (char)(adc_result & 0x000F);

uart_buffer[16] = (char)((a < 0x0A) ? (a + 0x30) :

/* Send

the string to the UART */

R_DEBUG_Print(uart_buffer);

}

- (a + 0x37));
: (a + 0x37));
s (a + 0x37));

(a + 0x37));

local.

/

/

* End of function uart_display_adc

/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.
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The project may now be run using the debugger as described in 86. Connect the RSK G1CUSBO port to a
USB port on a PC. If this is the first time the RSK has been connected to the PC then a device driver will be
installed automatically. Open Device Manager, the virtual COM port will now appear under 'Port (COM & LPT)'
as 'RSK USB Serial Port (COMXx)', where x is a number.

Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI1 (see §4.4.5).
When any switch is pressed, or when ‘c’ is sent via the COM port, the program will perform an A/D conversion
of the voltage level on the ADPOT line and display the result on the LCD panel and send the result to the PC
terminal program via the SCI1. Return to this point in the CG_Tutorial to add the LED user code.

5.7 LED Code Integration

Open the file ‘r_cg_main.c’. Add the following declaration to the user code area for include near the top of the
file:

#include "rskrx23tdef.h"

Add the following declaration to the user code area for global near the top of the file:

/* Prototype declaration for led_display_count */
static void led_display_count(const uint8_t count);

Add the following highlighted code to the user code area in the main function:

void main(void)

{
R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the switch module */
R_SWITCH_InitQ);
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCallback(cb_switch_press);
/* Initialize the debug LCD */
R_LCD_Init Q;
/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8_t *)" RSKRX23T ");
R_LCD Display(1, (uint8_t *)" Tutorial ");
R_LCD Display(2, (uint8_t *)" Press Any Switch ");
/* Start the A/D converter */
R_S12AD_Start();
/* Set up SCI1 receive buffer and callback function */
R_SCI11_Serial_Receive((uint8_t *)&g_rx_char, 1);
/* Enable SCI1 operations */
R_SCI1_Start();
while (1U)
{
uintl6_t adc_result;
/* Wait for user requested A/D conversion flag to be set(SW1 or Sw2) */
if (TRUE == g_adc_trigger)
/* Call the function to perform an A/D conversion */
adc_result = get_adc();
/* Display the result on the LCD */
Icd_display_adc(adc_result);
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/* Increment the adc_count and display using the LEDs */
if (16 == ++adc_count)
{

adc_count = 0;
led_display_count(adc_count);

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

/* Reset the flag */
g_adc_trigger = FALSE;

by

/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */

else if (TRUE == g_adc_complete)

{

/* Get the result of the A/D conversion */
R_S12AD_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count and display using the LEDs */
if (16 == ++adc_count)
{

adc_count = 0;
led_display_count(adc_count);

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

/* Reset the flag */
g_adc_complete = FALSE;

}

else

/* do nothing */
¥

/* End user code. Do not edit comment generated here */

}

Then, add the following function definition in the user code area at the end of the file:

/
* Function Name : led_display_count
* Description : Converts count to binary and displays on 4 LEDSO-3
* Argument : uint8_t count
* Return value : none
/
static void led_display_count (const uint8_t count)
{
/* Set LEDs according to lower nibble of count parameter */
LEDO = (uint8_t)((count & 0x01) ? LED_ON : LED_OFF);
LED1 = (uint8_t)((count & 0x02) ? LED_ON : LED_OFF);
LED2 = (uint8_t)((count & 0x04) ? LED_ON : LED_OFF);
LED3 = (uint8_t)((count & 0x08) ? LED_ON : LED_OFF);
ks
/
* End of function led_display_count
/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in 86. The code will perform the same but now
the LEDs will display the adc_count in binary form.
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6. Debugging the Project

e In the ‘Project Tree’ pane, right- =-| 7% CG Tutorial (Project)* " —]
click the ‘RX Simulator (Debug | RSF523TSAXFM (Microcontroller)
Tool)". Select ‘psmg Debug B_.J Code Generator (Design Tool) Siz
Tool -> RX El(SerlaI)’. _____ 4‘ CC-RX (Build Tool) 4 En

----- = R Simulator (Debug s Ene
B j.ll File Using Debug Tool  » || R E1(Serial) ||k
ﬂ Build toel generat| F property R E20(Serial) :
.| iodefine.h o
: « [ RX Simulator r
|_-ﬂ Code Generator e o
i ] € Source Files I

e Double-click ‘RX E1(Serial)
(Debug Tool)' to display the
debugger tool properties.
Under ‘Clock’, change the main
clock frequency to 20 MHz and

B Property
. _________________________________________________________________________________________________}

=, R¥ E1{Senal) Property
4 |Internal ROMRAM

Size of internal ROM[KBytes] 128
2

Size of internal RAM[KBytes]

operating frequency to 40MHz. Size of DataFlash memory[KBytes] 0
e Under ‘Connection with Target | 4 Clock
Board’, change ‘Power target mﬂ!"c:oct{souroe M E:TAL
gin ClOCK Treguency| z .
I(r)o‘n\; etge emulator.(MAX 200mA) Operating frequency[MHz] 40_'3““0

Allow changing of the clock source on writing internal flash memory  No
e All other settings can remain at | < Connectionwith Emulator

their defaults. Emulator serial Mo.
4 Connechionwith Target Board
Power target from the emulator [MAX 200mA) Yes
Supply voltage 33V
Communications method FINE
FIME baud rate[bps] 2000000

e Connect the E1 to the PC and
the RSK El connector.
Connect the Pmod LCD to the
PMOD1 connector.

e From the ‘Debug’ menu select
‘Download’ to start the debug
session and download code to
the target.
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7. Running the Code Generator Tutorial

7.1 Running the Tutorial

Once the program has been downloaded onto the RSK device, the program can be executed.
Click the ‘Go’ button or press F5 to begin the program from the current program counter
position. It is recommended that you run through the program once first, and then continue to
the Tutorial manual to review the code.

®
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8. Additional Information

Technical Support

For details on how to use CS+, refer to the
help file by opening CS+, then selecting Help
> Help Contents from the menu bar.

sol Window | Help

Help

@

@+ Open Help for Start Panel

@q‘q One Point Advice...

Ll

2]
=

UEK

|E 3

Tutorial
Learn

About...

Browse Renesas Electronics Microcontrollers Web

Detail Version Information...

F1

For information about the RX23T group microcontroller refer to the RX23T Group Hardware Manual.

For information about the RX assembly language, refer to the RX Family Software Manual.

Technical Contact Details

Please refer to the contact details listed in section 8 of the “Quick Start Guide”.

General information on Renesas microcontrollers can be found on the Renesas website at:

http://www.renesas.com/

Trademarks

All brand or product names used in this manual are trademarks or registered trademarks of their respective

companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics

Europe Limited.

© 2015 Renesas Electronics Europe Limited. All rights reserved.
© 2015 Renesas Electronics Corporation. All rights reserved.
© 2015 Renesas System Design Co., Ltd. All rights reserved.
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